
Can I use Fontographer and Illustrator out-
put both in the same Typestry file?

Ahhh. We were hoping you would ask that. See this
picture? It uses
both. Here’s the
story.

First, a nice fat little
star was created in
Fontographer.

Three separate star
“words” consisting
of 4, 11, and 5 star
characters (top,
middle, and bottom,
respectively) were
brought into Pixar
Typestry 2. The
stars were sized and
positioned. The wall background was added and the
file rendered. This rendered Black and White EPS
file was imported into Adobe Illustrator and the
strings were drawn in. The star image was deleted

and the strings were saved in three files (top, middle,
bottom). Each Adobe Illustrator string was imported
into Pixar Typestry 2, sized and positioned through

the appropriate set of
stars.

The Christmas ornament
was created using three of
the snowflakes in the Zapf
Dingbats font and the
Rubber Sheets option. The
top of the ornament is
simply an extruded Gill
Sans capital “O” with no
bevel. The hook eye is the
upper case “U” from the
Charlemagne font.

Grouping was extremely
handy for this project. All

the stars and strings were grouped as were the
ornament parts.

Looks:  The stars are EC Gems Dented Jewel with
the highlight strength and spread turned up and the
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Pits relief added. The string is a Threads relief, com-
bined with a shiny red Instance of the Metal Look.
The snowflakes on the ornament were created with
EC Gems-Corrosion, again with the highlight spread
and strength turned up. To this point all the Looks
were customized in Glimpse.

The blue ornament background is the Starter\Ma-
terials\Metal\Smooth\Chrome with the highlight
strength and spread turned up and the color set in
Typestry 2. The ornament top is Starter\Combina-
tions\Engraved Metal and the hook eye is Start-
er\Materials\Metal Polished set to gold.

Last but not least, the back wall is Pixar 128 Belizan
Mahogany.

Lights: #8 at 100% with a spot and shadows. #5 at
100% with a spot, focused tightly on the ornament
only.

Final rendered size was 7x5 inches at 300 dpi,
because it was intended to be used as a Christmas
card.

How do I change a word’s bevel?

Well first of all, you can change the bevel only for
whole objects that remain as they were generated in
the text dialog. This means that you can’t type in a
word, and change the bevel of one of its letters. You

must change the whole object. If you need to
change the bevel of a letter, you should type in the
letter separately and group it with the rest of the
word.

But to change an object’s bevel:

1. Select the object.

2. If it’s not already showing, bring up the Details
window by selecting Details from the Windows
menu.

3. Click on the Build tab.

4. Set the Bevel Style or Depth.

5. Click on the Modify button.

How do I kern letters in Typestry 2?

There are no facilities specifically designed to do
kerning per se, but you do have two options. First,
you can use Illustrator or CorelDraw 4.0 (or
greater) to adjust almost anything you’d like about
your text, and import that file. Second, within
Typestry you can always move individual letters to
adjust their spacing. This is best done with the
Camera (in the Effects menu) set to Telephoto:

1. Select Telephoto from the Camera menu (under
Effects).
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2. Select a letter (double-clicking to select the letter
as a subelement of a text object, if necessary).

3. Select the Move tool.

4. Hold down the Shift key to constrain the direc-
tion of motion while starting to drag the letter hori-
zontally.

5. Don’t forget to set the Camera view back to
Normal, if that’s what you were using.

How do I use my own texture on a word (or
wall or floor)?

1. Select the object.

2. If it’s not already showing, bring up the Details
window by selecting Details from the Windows
menu.

3. Click on the Look tab.

4. Click on the New Look button.

5. Use the Browser to find the Picture/Background
Look in the Looks\Simple\Useimage folder; then click
on Select.

6. Click on the Edit Look button in the Look tab.

7. Find the Color Picture parameter in the Look
Editor dialog and click on the Browse button. This
brings up the Select An Image dialog.

8. Click on the name of the image (in BMP or TIFF
format) you’d like to use. Set Wrapping On if you’d
like the image to repeat vertically and horizontally
across the surface; click on OK.

9. In the Look Editor, click on Save As and save the
Look.

10. Render! You may need to adjust the scale in the
Object Info dialog, available by clicking on the
Object Info button in the Look tab.

How do I avoid having letters run together?

If you use a large bevel size this may be unavoidable.
Using a smaller bevel size will help, but otherwise:

• Move the letters one at a time using the Shift key
to constrain motion to the horizontal (see the kern-
ing task above); or

• Type a space between each letter as you type in
the text dialog.

Can I use any font at all?

Typestry can only use a font if:
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• it is a Type 1 outline font present in the list in
the ATM Control application.

• it is a TrueType font present in the list in the
Fonts Control Panel.

• ATM is present and On.

Warning: Some TrueType and Type 1 fonts (typical-
ly shareware or freeware) are poorly or illegally con-
structed. If this is the case, Typestry may not be able
to properly convert characters into 3D.

Some of the packages you might use to create font
characters are Fontographer, FontMonger, and
CorelDraw. You can use Illustrator to create any
shape; it doesn’t output a font per se, just PostScript.

How do I adjust Looks (change color, size,
orientation, etc.)?

1. Select the text with the Look on it.

2. Click on the Object Info button in the Look tab
in the Details window.

3. Use the Object Info dialog to change the Look’s
size, color, orientation, opacity, and projection.

If you’d like to make more extensive changes you
should click on the Edit Look button in the Look tab
and use the Look Editor.

See the chapter on The Look Attribute for more
information on both of these procedures.

How can I speed up rendering?

• Use lower quality settings when appropriate (to
check on position, orientation, preliminary lighting,
etc.).

• Make your window smaller: larger images take
longer to render than smaller ones — you may not
always need to see things at full screen size.

• Use the crop window liberally. If you apply a
Look to some text, you may not need to see all of it
— a single letter might suffice.

• Use effects judiciously. Motion blur, perforations,
and shadows can all slow down rendering, and the
more perforations and shadows there are, the slow-
er the speed. Using your own pictures in Looks will
tend to slow things down somewhat, too.

• The more shadow-casting lights you have turned
on, the slower the rendering. Your image may need
a lot of lights, but you may not need all of them
every time you render.

If you’ve done all this, and you’re willing to spend
money to buy more speed you should consider
either accelerator boards or a faster machine.
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Some accelerator boards are designed specifically
for speeding up RenderMan renderers. Most generic
accelerator boards will also speed things up.

How do I guarantee enough memory to
render?

If you find you run out of memory when you render
a file, you’ll probably have to increase the Windows
“swap file” size. This is controlled by the Virtual
Memory control panel. Refer to your Windows doc-
umentation for instructions on how to change the
swap file size.

How do I improve the quality of my shad-
ows?

Shadows are computed for an image of a particular
size. If you have computed shadows for a small
screen image, and then render to a file (or window)
of larger dimensions without recomputing shadows,
you may get poor results.

When rendering to a file, always use “Compute
Shadows” instead of “Render with old Shadows,”
unless you know the old shadows are both correct
and an appropriate size.

How can I correct typos?

1. Select the object to be changed.

2. Bring up the Text tab in the Details window.
This displays the current text.

3. Type in the correct text (using the same font
and style settings!).

4. Click on Modify.

How can I get one word behind another?

1. For this you'll probably want to make sure the
words are in separate groups. Use the Score win-
dow to do this.

2. Then select Left or Top from the Camera
popup, available under the Effects menu. These
allow you to see the words from a more convenient
perspective. 

3. Use the Move tool to move the words into the
right positions.

4. Get the Front view back from the Camera
popup under Effects.
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How can I get reflections?

In a nutshell, to reflect on a floor, make a duplicate
of the object, reverse it, put it under the floor, and
make the floor semi-transparent. The process is
rather inexact, and is kind of cheating, but hey, what-
ever it takes... Here are the steps:

1. Create two identical versions of the text object.

2. Superimpose one on top of the other as accu-
rately as possible (see the next task).

3. Bring up the Scale dialog by holding down the
right mouse button while clicking on the object with
the Scale tool.

4. Click on Nonuniform and type –100 (that’s neg-
ative 100!) in the Height box.

5. Drag the reversed object down (using the Shift
key to constrain movement) so its top meets the
bottom of the regular object. This will be the reflec-
tion. (If you want the object to look like it’s floating
in air, the reflection won’t meet it, so move the bot-
tom one farther away.)

6. Group the two objects. This way you can adjust
them (move, rotate, etc.) together.

7. Select Floor from the Backgrounds menu item
under the Effects menu.

8. Now select Floor Setup from the same menu.

9. Click on the Manual setting and try to line the
floor up so it falls exactly halfway between the two
objects; click on OK.

10. After you’ve applied a Look to the floor, get the
Object Info dialog by clicking on the More Info but-
ton in the Look tab.

11. Turn down the Opacity a little so it’s around 80
or 90%, and click on OK. (You’ll have to experiment
with this setting to get just the reflective effect you
want.)

12. Render.

This trick has its limits. Since the “reflection” is really
just another object, its surface won’t look upside
down with respect to its counterpart (though you
may be able to adjust this by flipping the Look in the
Object Info dialog, depending on the Look). But you
may not see enough of it to really notice.

Also, if the object is tilted forward or back, its reflec-
tion will have to be tilted in the opposite direction.
You should do this before you group the words.

To reflect on a wall, you’ll have to put a copy of the
object (not reversed, as for the floor) behind the
wall. See the “How can I get one word behind
another” task for this procedure. Check the Wall
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Setup dialog (from Backgrounds under the Effects
menu) for placement of the wall and the objects in
relation to it.

What’s the best way to align things?

1. Select Telephoto from the Camera menu item
under the Effects menu.

2. Select Preferences from the File menu and
increase Wireframe Complexity to the maximum.
Also, set the grid dimensions to some number that
will give you enough grid marks to help line things
up: 25x25, 40x40, whatever works for you.

3. Make your window as big as possible.

4. Select Toggle Grid from the Edit menu.

5. Line your objects up.

5. When you’re done, set the Camera back to
what it was!

How can I get a light to track by itself?

A light can only track an object, but you can create
an invisible object (maybe just a single character) for
the light to track, so it looks like it’s tracking by itself.
To make an object invisible, just turn its Opacity set-
ting all the way down in the Object Info dialog, avail-

able by clicking on the Object Info button in the
Look tab in the Details window. (You must first
apply a Look to it.)

I rendered a word and brought it into my
page layout program, and I got the word on
a black background. How do I get rid of the
background?

The short answer is you can’t, unless like Adobe
Photoshop, your page layout program (or whatever)
uses an alpha, or matte, channel. If an alpha channel
is supported, then:

1. In Typestry, select Preferences from the File
menu.

2. Make sure the “Transparent” Colored button is
selected.

3. Click on OK.

But if you just need a white background in your
image so it blends in with a white page, the solution
is simple. Use the steps above, but make sure the
“Empty Space” Colored button is selected, and that
the color is pure white.

When you rerender, you’ll have a white background.
Of course, the Empty Space color can be anything,
and so can match any solid background you may
have.
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But what if you want the word to lie on top of an
image you already have on a page? Well, the fact of
the matter is, you’re stuck with importing a rectan-
gular area. But despair not, for Typestry is capable of
making empty areas of an image disappear using
“coverage.”

The theory is, modify the idea of a pixel so that in
addition to color information, it includes an amount
of coverage. Now, when you bring in an image over
a background, for each pixel in your image you can
ask the question, “Should this pixel cover what’s
under it?” If the answer is yes, you see the regular
dot of color in the image. If the answer is no, you
see the background. Voila! A rectangular image cov-
ering a non-rectangular area!

Using the alpha channel, not only can we turn cov-
erage on and off, we can also turn it on a little, a lot,
or anywhere in between. Turning it on completely
for a part of an image makes that part completely
opaque. Turning it off makes it completely transpar-
ent. Anywhere in between makes it semi-transpar-
ent.

In those programs that know what to do with alpha
information (“support” an alpha channel), each pixel
of an image is described by four values, three for
color (RGB) and one for coverage (alpha). In those
programs that don’t support alpha, an image’s pixels

have only RGB values, and all the pixels are just
there, covering everything.

Currently, there’s a problem. We’re in one of those
transition times where some software supports an
alpha channel, and some doesn’t. Unfortunately,
most page layout and paint programs don’t yet sup-
port alpha. So where’s this leave us?

Well, it depends on what you need to do. If you
want to include a Typestry word in an image you’ve
made, buy a program that supports a matte, or mask
channel and just copy the “covered” part of the
Typestry image into your image. No unsightly rec-
tangle, no extra pixels, just the word.

If you want to put a Typestry word over your text,
you’ll either have to plan on having a rectangle
around the word or lobby for your application to
support an alpha channel!

How do I know what size and resolution and
stuff like that to use if I’m printing to a laser
printer (or Lino, etc.)?

OK. We’ll assume you’ve made your project win-
dow the shape you want your image to be.
Additionally, you must know what linescreen you’ll
be using when you go to print. If you don’t know
about this, read on. If you’re printing on a laser prit-
er, figure on 60. Then:
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1. In the Image Format dialog (under the Render
menu), click on the “>>” button to load these val-
ues into the Output File boxes.

2. Check the Constrain Aspect Ratio box.

3. Change the popup from pixels to inches.

4. Enter the Width and Height of the image as it
should appear on the printed page.

5. Multiply your linescreen number by 1.5 and type
this in the Resolution box.

6. Render to file.

And now a little explanation. No matter what print-
er you’re going to use, you need only decide on a
linescreen value to know what numbers to use in
Typestry. The linescreen number is typically some-
thing like 60 for a 300 dpi laser printer, and more
like 120–150 when going to Lino or high-resolution
imagesetters. The linescreen basically determines
how coarse the image looks.

Bear in mind that the higher the linescreen number,
the less color subtlety you’ll see in any but the high-
est-resolution imagesetters (2400 dpi or more).

For the Resolution you can actually use a number
that’s between 1 and 2 times the linescreen number,
and you may want to try a test or two to see what
you like best. But 1.5 should work pretty well.

How can I get my animations out to video?

If you want to see your animation in real time,
you’re probably going to have to get fancy and
spend money. Video for Windows is useful for many
purposes, but to get real speed and large frame
capabilities, you may want to look at video systems.
These can consist of a board to plug in your
machine and software that allows you to record a
series of images onto frames of videotape. You can
then edit frames, add special effects, and so on. And
of course, you’ll be able to play them back at video
rates, just like you see on your television. Some
packages (Diaquest, for example) can record either
individual frames, or whole AVI movies to video disk
or tape.

Are there any rules of thumb for getting
good results in Typestry?

While there are a lot of ways to make a good pic-
ture using Pixar Typestry, there are also a lot of
ways to make a bad one. To help you avoid some of
the pitfalls in the process we’ve come up with some
tips and caveats.

• Lighting from above (lights 1, 4, and 7) tends to
look most “natural.”

• A reasonable light setup could have all lights off,
except for light 7, which should be all the way on.
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(An unreasonable setup would have all the lights
on.)

• When using perforations, usually a small bevel
size will help readability.

• Avoid using transparency when bevel size is large
unless you want to see the internal structure of a
letter’s beveling.

• When using motion blur, the longer the streak,
the more dissipated it will look.

• To get highlights on objects where you want
them, think of the surface as a mirror; tilt the object
(or move the light) so you could see the light in the
mirror.
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